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法律资讯 
警告提示系统 

为了您的人身安全以及避免财产损失，必须注意本手册中的提示。人身安全的提示用一个警告三角表示，仅

与财产损失有关的提示不带警告三角。警告提示根据危险等级由高到低如下表示。 

 危险 

表示如果不采取相应的小心措施，将会导致死亡或者严重的人身伤害。 
 

 警告 

表示如果不采取相应的小心措施，可能导致死亡或者严重的人身伤害。 
 

 小心 

表示如果不采取相应的小心措施，可能导致轻微的人身伤害。 
 

 注意 

表示如果不采取相应的小心措施，可能导致财产损失。 

当出现多个危险等级的情况下，每次总是使用最高等级的警告提示。如果在某个警告提示中带有警告可能导

致人身伤害的警告三角，则可能在该警告提示中另外还附带有可能导致财产损失的警告。 

合格的专业人员 
本文件所属的产品/系统只允许由符合各项工作要求的合格人员进行操作。其操作必须遵照各自附带的文件说

明，特别是其中的安全及警告提示。 
由于具备相关培训及经验，合格人员可以察觉本产品/系统的风险，并避免可能的危险。 

按规定使用Siemens 产品 
请注意下列说明： 

 警告 

Siemens 
产品只允许用于目录和相关技术文件中规定的使用情况。如果要使用其他公司的产品和组件，必须得到 
Siemens 
推荐和允许。正确的运输、储存、组装、装配、安装、调试、操作和维护是产品安全、正常运行的前提。必

须保证允许的环境条件。必须注意相关文件中的提示。 

商标 
所有带有标记符号 ® 的都是西门子股份有限公司的注册商标。本印刷品中的其他符号可能是一些其他商标。

若第三方出于自身目的使用这些商标，将侵害其所有者的权利。 

责任免除 
我们已对印刷品中所述内容与硬件和软件的一致性作过检查。然而不排除存在偏差的可能性，因此我们不保

证印刷品中所述内容与硬件和软件完全一致。印刷品中的数据都按规定经过检测，必要的修正值包含在下一

版本中。 
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SINAMICS 文档  

SINAMICS 文档分为以下几个类别： 

● 通用文档/产品样本 

● 用户文档 

● 制造商/服务文档 

其它信息 
访问下面的网址 
(https://support.industry.siemens.com/cs/de/en/view/108993276)获取有关该主题的信息： 

● 订购文档/查看印刷品一览 

● 进入下载文档的链接 

● 使用在线文档（查找搜索手册/信息） 

如果您对技术文档有疑问（例如：建议或修改），请发送一份电子邮件到下列地址 
(mailto:docu.motioncontrol@siemens.com)。 

Siemens MySupport/文档 

您可以访问下面的网址 
(https://support.industry.siemens.com/My/ww/en/documentation)，了解如何随意组合西

门子文档内容，再结合机器，创建自己的机器文档。 

培训 
通过以下地址 (http://www.siemens.com/sitrain)可获取有关 SITRAIN 的信息 - 
西门子为驱动和自动化产品、系统和解决方案制定的培训。 

常见问题 

常见问题（FAQ）请参见产品支持 
(https://support.industry.siemens.com/cs/de/en/ps/faq)下的服务&支持页面。 

SINAMICS 
关于 SINAMICS 的信息请参见以下地址 (http://www.siemens.com/sinamics)。 
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适用范围与其文档/工具（示例）  

表格 1 适用范围和可供使用的文档/工具 

适用范围 文档/工具 

定位 SINAMICS S 销售文档 

设计/配置 • 选型工具 SIZER 
• 电机选型手册 

决定/订购 SINAMICS S120 产品样本 
• SIMOTION、SINAMICS S120 及生产机械电机（产品样本 PM 21） 
• SINAMICS 和用于单轴驱动的电机（产品样本 D 31） 
• SINUMERIK & SINAMICS  

机床设备（产品样本 NC 61） 
• SINUMERIK 840D sl 1B 型 

机床设备（产品样本 NC 62） 

安装/装配 • SINAMICS S120 控制单元和扩展系统组件手册 
• SINAMICS S120 书本型功率单元手册 
• SINAMICS S120 书本型功率单元手册 (C/D) 
• SINAMICS S120 风冷式装机装柜型功率单元手册 
• SINAMICS S120 液冷式装机装柜型功率单元手册 
• SINAMICS S120 AC 驱动手册 
• SINAMICS S120 Combi 设备手册 
• SINAMICS S120M 分布式驱动技术手册 
• SINAMICS HLA 液压驱动系统手册 

调试 • 调试工具 STARTER 
• SINAMICS S120 STARTER 入门指南 
• SINAMICS S120 STARTER 调试手册 
• SINAMICS S120 CANopen 调试手册 
• SINAMICS S120 驱动功能手册 
• SINAMICS S120 Safety Integrated 功能手册 
• SINAMICS S120/S150 参数手册 
• SINAMICS HLA 液压驱动系统手册 
• Startdrive 调试工具1) 
• SINAMICS S120 Startdrive 入门指南1) 
• SINAMICS S120 Startdrive 调试手册1) 
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适用范围 文档/工具 

使用/操作 • SINAMICS S120 STARTER 调试手册 
• SINAMICS S120/S150 参数手册 
• SINAMICS HLA 液压驱动系统手册 
• SINAMICS S120 Startdrive 调试手册1) 

维护/维修 • SINAMICS S120 STARTER 调试手册 
• SINAMICS S120/S150 参数手册 
• SINAMICS S120 Startdrive 调试手册1) 

文档目录 • SINAMICS S120/S150 参数手册 
 1) 自 Startdrive V14 释放起可用 

目标使用人群 

本文档供使用 SINAMICS 驱动系统的机器制造商、调试人员和维修人员使用。 

优点 

本文档介绍了各个使用阶段的必要信息、步骤和/或操作。 

标准功能范畴 

本文档描述的功能范畴可能和实际提供的驱动系统的功能范畴有偏差。 

● 在驱动系统中也可能会运行本文档中未说明的功能。但这并不表示在交付系统时必须

提供这些功能以及相关的维修服务。 

● 本文档中也可能会描述驱动系统上不存在的功能。提供的驱动系统的功能请参见订货

资料。 

● 机床制造商增添或者更改的功能，必须由机床制造商进行说明。 

同样，为使文档简明清晰，本文档并不包含所有产品类型的所有信息，也不能考虑到订货

、销售和维护的每种实际情况。  

技术支持 

访问网址 (https://support.industry.siemens.com/sc/cn/zh/sc/-
/oid2090)中的“联系”，您便可以获取各个国家技术支持的电话号码。 
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相关指令和标准 

您可从西门子办事处获取最新的已认证组件的清单。尚未完成的认证请咨询您的西门子联

系人。  

证书下载 

证书可从以下网站上下载：  

证书 (https://support.industry.siemens.com/cs/ww/de/ps/13206/cert)  

欧盟符合性声明 

访问网址 
(https://support.industry.siemens.com/cs/cn/zh/ps/13231/cert)便可获取有关重要标准的

欧盟符合性声明以及重要认证、模块模板检测证明、制造商声明和功能安全（“Safety 
Integrated”）的功能检测证明的信息。  

 

SINAMICS S 系列产品适用以下指令和标准： 

欧洲低压指令 

SINAMICS S 系列产品在低压指令 2014/35/EU 
的应用范围中工作时即满足该指令的要求。 

欧洲机械指令 

SINAMICS S 系列产品在机械指令 2006/42/EU 
的应用范围中工作时即满足该指令的要求。 

不过在典型的机械应用中，SINAMICS S 
系列产品完全符合该指令对人身健康安全的基本规定。 

欧洲 EMC 指令 

SINAMICS S 系列产品满足 EMC 指令 2014/30/EU 的要求。 

韩国适用的 EMC 标准 

带有 KC 标志的 SINAMICS S 系列产品符合韩国 EMC 标准。 

半导体过程设备承受的电压暂降等级标准 

SINAMICS S 系列产品符合 SEMI F47-0706 标准的要求。 

海关联盟认证 

SINAMICS S 系列产品满足俄罗斯/白俄罗斯/哈萨克斯坦海关联盟 (EAC) 的要求。 
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北美市场 

SINAMICS S 系列产品带有图形检验标识，在作为驱动应用组件时满足北美市场的要求。 

证书请从认证网页上获取： 

● 包含UL 认证 (http://database.ul.com/cgi-
bin/XYV/template/LISEXT/1FRAME/index.html)的产品 

● 包含TÜV SÜD 认证 (https://www.tuev-
sued.de/industry_and_consumer_products/certificates)的产品 

可能适用的检验标识 
 

      

澳大利亚及新西兰（RCM，旧称 C-Tick） 

SINAMICS S 系列产品带有图形标识，满足澳大利亚及新西兰的 EMC 要求。 

质量系统 

西门子股份公司达到 ISO 9001 和 ISO 14001 质量管理体系的要求。 

无关标准 

中国强制性产品认证 

SINAMICS S 系列产品不属于中国强制性产品认证 (CCC) 的约束范围。 

韩国的 EMC 限值 

 

韩国规定的 EMC 限值和欧盟发布的电气调速驱动器 EMC 产品标准 EN 61800-3 C2 类或 
KN11，1 组 A 类规定的限值一致。请采取适当的附加措施，确保装置符合 C2 类或 1 
组，A 类规定的限值。为此需要采取附加措施，比如使用附加的抗射频滤波器（EMC 
滤波器）。 
其他一些确保正确 EMC 安装的措施在本手册或选型手册中的“ EMC 
安装指南”一节中详细说明。 
无论如何都要始终注意设备上贴附的标签，标签上的说明对符合标准至关重要。 
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确保可靠运行 

本手册描述的状态是设备的标准状态，保持此状态即可确保可靠运行，并且不超出 EMC 
限值。 

如不符合该设备手册中的要求，应采用适当的措施如测量来确定或验证，设备能够正常运

行且保持在 EMC 限值以内。 

备件 

备件信息请访问以下网址 (https://www.automation.siemens.com/sow?sap-
language=EN)。  

产品维护 

在产品维护（提高耐用性、部件报废等）的范畴内，组件会持续得到进一步研发。 

此类研发可无需变更产品编号而实现“备件兼容”。 

这样的备件兼容式再研发有时会对连接器/接口位置进行略微的调整，但这不会对组件的

规范使用产生影响。请在特殊的安装情况下加以注意（例如电缆长度要有足够余量）。 

使用第三方产品 

本印刷品包含有对第三方产品的推荐。西门子了解这些第三方产品的基本适性。  

可以使用其他制造商的同等产品。  

西门子不对第三方产品的使用提供担保。 
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接地符号 

表格 2 符号 

符号 含义 

 

 

 

接地线的连接（PE） 

 

 

 

接地 = 地（例如：M 24 V） 

 

 

 

电位平衡功能连接 

书写方式 

本文档中使用以下书写方式和缩写： 

故障和报警书写方式（示例）： 
 
• F12345 故障 12345（英语：Fault） 
• A67890 报警 67890（英语：Alarm） 
• C23456 安全信息 

参数书写方式（示例）： 
 
• p0918 可调参数 918 
• r1024 显示参数 1024 
• p1070[1] 可调参数 1070，下标 1 
• p2098[1].3 可调参数 2098，下标 1，位 3 
• p0099[0...3] 可调参数 99，下标 0 到 3 
• r0945[2]（3） 驱动对象 3 的显示参数 945，下标 2 
• p0795.4 可调参数 795，位 4 
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文档目标 

本文档针对想要学习 SINAMICS S120 驱动系统的入门人员， 
以一个简单的SINAMICS S120驱动项目为例对调试过程进行简要介绍。 
参照此文档中的说明，仅需几分钟就可以完成示例项目的选型配置并使电机运转起来。  

示例项目借助于 SINAMICS S120 培训箱完成。 



 

STARTER 入门指南 
入门指南, (GS1) 07/2016, 6SL3097-4AG00-0RP4 13 

目录  
 

 前言 .................................................................................................................................................. 5 

1 基本安全说明 .................................................................................................................................. 15 

1.1 一般安全说明 ................................................................................................................... 15 

1.2 有关电磁场（EMF）的安全说明 ...................................................................................... 20 

1.3 操作静电敏感元器件（ESD） .......................................................................................... 21 

1.4 工业安全 ........................................................................................................................... 22 

1.5 驱动系统（电气传动系统）的遗留风险 ........................................................................... 24 

2 SINAMICS S120 驱动系统 .............................................................................................................. 25 

3 概述 ................................................................................................................................................ 27 

4 硬件组件 ......................................................................................................................................... 29 

4.1 示例配置的组件 ................................................................................................................ 29 

4.2 SINAMICS S120培训箱系统数据 ..................................................................................... 30 

4.3 组件的布线 ....................................................................................................................... 32 

5 创建驱动对象 .................................................................................................................................. 33 

5.1 一览 .................................................................................................................................. 33 

5.2 设置通讯接口 ................................................................................................................... 34 
5.2.1 设置以太网接口 ................................................................................................................ 34 
5.2.2 调用 STARTER ................................................................................................................ 35 
5.2.3 在STARTER中分配以太网接口 ....................................................................................... 36 

5.3 创建驱动项目 ................................................................................................................... 38 

6 配置驱动对象 .................................................................................................................................. 41 

6.1 配置驱动设备 ................................................................................................................... 41 

6.2 配置电机模块 ................................................................................................................... 45 

6.3 SINAMICS S120培训箱的特殊之处 ................................................................................. 46 

7 调试驱动 ......................................................................................................................................... 49 

A 附录 ................................................................................................................................................ 55 

A.1 重要报警和故障列表 ........................................................................................................ 55 

A.2 恢复出厂设置 ................................................................................................................... 57 

A.3 手册一览 ........................................................................................................................... 59 



目录  
 

 STARTER 入门指南 
14 入门指南, (GS1) 07/2016, 6SL3097-4AG00-0RP4 



 

STARTER 入门指南 
入门指南, (GS1) 07/2016, 6SL3097-4AG00-0RP4 15 

 基本安全说明 1 
1.1 一般安全说明 
 

 

危险 

接触带电部件和其他能源供给会引发生命危险 
接触带电部件会造成人员重伤，甚至死亡。 

• 只有专业人员才允许在电气设备上作业。 

• 在所有作业中必须遵守本国的安全规定。 
通常有六项安全步骤： 

1. 做好断电的准备工作，并通知会受断电影响的组员。 

2. 断开设备电源。 

– 关闭设备。 

– 请等待至警告牌上说明的放电时间届满。 

– 确认导线与导线之间和导线与接地线之间无电压。 

– 确认辅助电压回路已断电。 

– 确认电机无法运动。 

3. 检查其他所有危险的能源供给，例如：压缩空气、液压、水。 

4. 断开所有危险的能源供给，措施比如有：闭合开关、接地或短接或闭合阀门。 

5. 确定能源供给不会自动接通。 

6. 确保正确的设备已经完全闭锁。 
结束作业后以相反的顺序恢复设备的就绪状态。  

 

 

 

警告 

连接了不合适的电源所产生的危险电压可引发生命危险 
接触带电部件可能会造成人员重伤或死亡。 

• 所有的连接和端子只允许使用可以提供 SELV(Safety Extra Low Voltage：安全低压) 
或 PELV(Protective Extra Low Voltage：保护低压) 输出电压的电源。 
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警告 

接触损坏设备上的带电压部件可引发生命危险 
未按规定操作设备可能会对其造成损坏。 
设备损坏后，其外壳或裸露部件可能会带有危险电压，接触外壳或这些裸露部件可能会

导致重伤或死亡。 

• 在运输、存放和运行设备时应遵循技术数据中给定的限值。 

• 不要使用已损坏的设备。 
 

 

 

警告 

电缆屏蔽层未接地可引起电击从而导致生命危险 
电缆屏蔽层未接地时，电容超临界耦合可能会出现致命的接触电压。 

• 电缆屏蔽层和未使用的功率电缆芯线（如抱闸芯线）至少有一侧通过接地的外壳接地

。 
 

 

 

警告 

未接地可引起电击从而导致生命危险 
防护等级 I 
的设备缺少安全接地连接或连接出错时，在其裸露的部件上会留有高压，接触该部件会

导致重伤或死亡。 

• 按照规定对设备进行接地。 
 

 

 

警告 

运行时断开插接可引起电击从而导致生命危险 
运行时断开插接所产生的电弧可引起重伤或死亡。 

• 如果没有明确说明可以在运行时断开插接，则只能在断电时才能断开连接。 
 



 基本安全说明 
 1.1 一般安全说明 
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注意 

电气连接件松动可造成财产损失 
紧固扭矩不足或振动可能会导致电气连接件松动，从而导致火灾、设备损坏或功能异常

。 

• 用规定的紧固扭矩拧紧所有的电气连接件，比如电源接线端子、电机接线端子、直流

母线连接件。 

• 请定期检查所有的电气连接件。尤其是在运输之后。 
 

 

 警告 

外壳大小空间不足可引起火灾从而导致生命危险 
明火和烟雾可引起重大人员伤亡或财产损失。  

• 没有保护外壳的设备应安装在金属机柜中（或采取相同效果的措施进行保护），以避

免设备接触明火。 

• 确保烟雾只能经所设安全通道排出。 
 

 

 警告 

使用移动无线电装置或移动电话时机器的意外运动可引发生命危险 
在距离本组件大约 2 m 的范围内使用发射功率大于 1 W 
的移动无线电设备或移动电话时，会导致设备功能故障，该故障会对设备功能安全产生

影响并能导致人员伤亡或财产损失。 

• 关闭设备附近的无线电设备或移动电话。 
 

 

 警告 

绝缘过载可引起火灾从而导致生命危险 
在 IT 
电网中接地会使电机绝缘增加负荷。绝缘失效可产生烟雾，引发火灾，从而造成严重人

身伤害或死亡。 

• 使用可以报告绝缘故障的监控设备。 

• 尽快消除故障，以避免电机绝缘过载。 
 



基本安全说明  
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 警告 

通风不足会引起过热、引发火灾，从而导致生命危险 
通风空间不足会导致过热，产生烟雾，引发火灾，从而造成人身伤害。 
这可能会造成人员重伤或死亡。此外，设备/系统故障率可能会因此升高，使用寿命缩短

。 

• 组件之间应保持规定的最小间距，以便通风。 
 

 

 警告 

缺少警示牌或警示牌不清晰可导致事故 
缺少警示牌或警示牌不清晰可能会导致严重人身伤害或死亡。 

• 根据文档检查警示牌的完整性。 

• 为组件安装警示牌，必要时安装本国语言的警示牌。 

• 替换掉不清晰的警示牌。 
 

 

 
注意 

不符合规定的电压/绝缘检测可损坏设备 
不符合规定的电压/绝缘检测可导致设备损坏。 

• 进行机器/设备的电压/绝缘检测前应先断开设备，因为所有的变频器和电机在出厂时

都已进行过高压检测，所以无需在机器/设备内再次进行检测。 
 

 

 警告 

无效的安全功能可导致生命危险 
无效的或不适合的安全功能可引起机器功能故障，可能导致重伤或死亡。  

• 调试前请注意相关产品文档中的信息。 

• 对整个系统和所有安全相关的组件进行安全监控，以确保安全功能。 

• 进行适当设置，以确保所使用的安全功能是与驱动任务和自动化任务相匹配并激活的

。 

• 执行功能测试。 

• 在确保了机器的的安全功能能正常工作后，才开始投入生产。 
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说明 

Safety Integrated 功能的重要安全说明 
使用 Safety Integrated 功能时务必要注意 Safety Integrated 手册中的安全说明。 

 

 

 警告 

因参数设置错误或修改参数设置引起机器误操作可引发生命危险 
参数设置错误可导致机器出现误操作，从而导致人员重伤或死亡。 

• 防止恶意访问参数设置。 

• 采取适当措施（如驻停或急停）应答可能的误操作。 
 

 



基本安全说明  
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1.2 有关电磁场（EMF）的安全说明 
 

 

警告 

电磁场可引发生命危险 
在电气能源技术设备例如变压器、变频器、电机运行时会产生电磁场 (EMF)。 
因此可能会对设备/系统附近的人员，特别是对那些带有心脏起搏器或医疗植入体等器械

的人员造成危险。 

• 确保相关人员和设备保持一定的距离（至少为 2 m）。 
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1.3 操作静电敏感元器件（ESD） 
静电敏感元器件 (ESD) 
是可被静电场或静电放电损坏的元器件、集成电路、电路板或设备。 

 

 

注意 

电场或静电放电可损坏设备 
电场或静电放电可能会损坏单个元件、集成电路、模块或设备，从而导致功能故障。 

• 仅允许使用原始产品包装或其他合适的包装材料（例如：导电的泡沫橡胶或铝箔）包

装、存储、运输和发运电子元件、模块和设备。 

• 只有采取了以下接地措施之一，才允许接触元件、模块和设备： 

– 佩戴防静电腕带 

– 在带有导电地板的防静电区域中穿着防静电鞋或配带防静电接地带 

• 电子元件、模块或设备只能放置在导电性的垫板上（带防静电垫板的工作台、导电的

防静电泡沫材料、防静电包装袋、防静电运输容器）。 
 

 



基本安全说明  
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1.4 工业安全 
 

 
说明 

工业安全 
西门子为其产品及解决方案提供工业安全功能，以支持工厂、解决方案、机器、设备和/
或网络的安全运行。 这些功能是整个工业安全机制的重要组成部分。 
有鉴于此，西门子不断对产品和解决方案进行开发和完善。西门子强烈建议您定期了解产

品更新和升级信息。 
此外，要确保西门子产品和解决方案的安全操作，还须采取适当的预防措施（例如：设备

单元保护机制），并将每个组件纳入先进且全面的工业安全保护机制中。 
可能使用的所有第三方产品须一并考虑。 更多有关工业安全的信息，请访问 网址 
(http://www.siemens.com/industrialsecurity)。 
要及时了解有关产品的更新和升级信息，请订阅相关产品的时事通讯。 
更多相关信息请访问 网址 (http://support.automation.siemens.com)。  

 

 警告 

篡改软件会引起不安全的驱动状态从而导致危险 
篡改软件（如：病毒、木马、蠕虫、恶意软件）可使设备处于不安全的运行状态，从而

可能导致死亡、重伤和财产损失。 

• 请使用最新版软件。 

相关信息和新闻请访问 网址 (http://support.automation.siemens.com)。  

• 根据当前技术版本，将自动化组件和驱动组件整合至设备或机器的整体工业安全机制

中。 

更多相关信息请访问 网址 (http://www.siemens.com/industrialsecurity)。  

• 在整体工业安全机制中要注意所有使用的产品。 
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 警告 

使用移动存储设备可导致危及人身安全的软件中毒 
将文件保存在移动存储设备上会带来较高的感染病毒或恶意软件的风险。参数设置错误

可导致机器出现误操作，从而导致人员重伤或死亡。 

• 采取相应的保护措施（如杀毒软件）防止移动存储设备中的文件受到恶意软件的破坏

。 
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1.5 驱动系统（电气传动系统）的遗留风险 
机器或设备制造商在依据相应的本地指令（比如欧盟机械指令）对机器或设备进行风险评

估时，必须注意驱动系统的控制组件和驱动组件会产生以下遗留风险： 

1. 调试、运行、维护和维修时机器或设备部件意外运行，原因（举例）： 

– 编码器、控制器、执行器和连接器中出现了硬件故障和/或软件故障 

– 控制器和传动设备的响应时间 

– 运行和/或环境条件不符合规定 

– 凝露/导电杂质 

– 参数设置、编程、布线和安装出错 

– 在电子器件附近使用无线电装置/移动电话 

– 外部影响/损坏 

– X 射线辐射、电离辐射和宇宙辐射 

2. 在出现故障时，组件内/外部出现异常温度、明火以及异常亮光、噪音、杂质、气体等，

原因可能有： 

– 零件失灵 

– 软件故障 

– 运行和/或环境条件不符合规定 

– 外部影响/损坏 

3. 危险的接触电压，原因（举例）： 

– 零件失灵 

– 静电充电感应 

– 静充电感应 

– 运行和/或环境条件不符合规定 

– 凝露/导电杂质 

– 外部影响/损坏 

4. 设备运行中产生的电场、磁场和电磁场可能会损坏近距离的心脏起搏器支架、医疗植

入体或其它金属物。 

5. 当不按照规定操作以及/或违规处理废弃组件时，会释放破坏环境的物质并且产生辐射。 

其它有关驱动系统组件产生的遗留风险的信息见用户技术文档的相关章节。 
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 SINAMICS S120 驱动系统 2 
 

 

模块化系统，适用于要求苛刻的驱动任务  

SINAMICS S120 
可以胜任各个工业应用领域中要求苛刻的驱动任务，并因此设计为模块化的系统组件。 
大量部件和功能相互之间具有协调性，用户因此可以进行组合使用，以构成最佳方案。 
功能卓越的组态工具 SIZER 使选型和驱动配置的优化计算变得易如反掌。 

丰富的电机型号组配使 SINAMICS S120 的功能更加强大。 
不管是扭矩电机、同步电机还是异步电机，或者是旋转电机或直线电机，都可以获得 
SINAMICS S120 的最佳支持。 

配有中央控制单元的系统架构 

在 SINAMICS S120 上，驱动器的智能控制、闭环控制都在控制单元中实现， 
它不仅负责矢量控制、伺服控制，还负责 V/f 控制， 
另外，控制单元还负责所有驱动轴的转速控制、转矩控制，以及驱动器的其他智能功能。 
各轴的互联可在一个控制单元内实现，并且只需在 STARTER 
调试工具中点击鼠标即可进行组态。 



SINAMICS S120 驱动系统  
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系统一览 

SINAMICS S120 
驱动系统由不同的模块组成，包括供电模块、滤波器模块、电机功率单元、附加功能模块

、控制单元、标准型及特殊型旋转电机和直线电机。  
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 概述 3 
 

 

本手册以一个简单的SINAMICS S120驱动项目为例对调试过程进行介绍。  

要创建示例项目，必须先明确以下几点： 

1. 示例项目中使用了哪些硬件组件？ 

2. 如何在 STARTER 中创建简单项目？ 

3. 如何配置驱动？ 

4. 如何调试驱动？ 

 



概述  
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 硬件组件 4 
4.1 示例配置的组件 

示例配置中包含以下组件：  

● 固件版本 4.5 以上的 CU320-2 DP，集成以太网接口 

● 非调节型电源模块（供电模块） 

● 电源滤波器 

● 双轴电机模块 

● 电源电抗器（ALM 和 SLM 上） 

● 同步伺服电机，带绝对值编码器和 DRIVE-CLiQ 接口 

● 带有Windows操作系统的标准PC，用作编程器（PG/PC），并安装了固件版本4.3以
上的调试工具STARTER。 
以下步骤针对的是Windows 7操作系统，在其他操作系统上（例如：Windows 
XP）步骤可能会有所偏差。 

● 已安装的动力电缆、电源电缆和控制电缆 

● DRIVE-CLiQ 电缆 

● PG/PC中的以太网接口 

● PG/PC和控制单元之间的以太网连接 

 



硬件组件  
4.2 SINAMICS S120培训箱系统数据 
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4.2 SINAMICS S120培训箱系统数据 
示例配置是在SINAMICS S120培训箱上执行的。  

 

图 4-1 培训箱 

使用的培训箱有以下技术数据：  

构造 

驱动系统的组成部分： 

● 控制单元CU320-2，带端子板TB30 

● 非调节型电源模块 5 kW，双轴电机模块 3 A 

● 1 个同步伺服电机 1FK7022-5AK71-1AG3，带增量式编码器， sin/cos 1 Vpp，通过 
SMC 20 接入 

● 1 个同步伺服电机 1FK7022-5AK71-1LG3，带绝对值编码器 2048 和 DRIVE-CLiQ 
接口。 

● 用于位置监控的基准垫片 

 

培训箱发货时配有演示项目（位于存储卡上）和文档。 
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技术数据 

防护等级，符合DIN VDE 0470 
第1部分/ EN 60529/ IEC 529 

IP20 

输入电压 1) • 1 AC 230 V/50 Hz 

• 通过电源适配器 1 AC 115 V 
（USA）（不在供货范围内） 

尺寸（宽 x 高 x 深），单位 mm 320 × 650 × 330 

重量 大约 30 kg 
 1) 需要注意各个电网运营商的连接条件。 

 

 

选型和订货数据 产品编号 

培训箱 

SINAMICS S120 TK-SIN-CU320-2 

双轴型，带 1FK7 电机 

• 带 CU320-2 DP 和演示项目 

• 带 CU320-2 PN 和演示项目 

 

 

 

6ZB2480-0CM00 

6ZB2480-0CN00 

电源适配器 

1 AC 115 V/1 AC 230 V 

 

6AG1 064-1AA02-0AA0 

SINAMICS 操作箱  
（单独订货） 

6AG1 064-1AA01-0AA0 
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4.3 组件的布线 
示例中的组件在SINAMICS培训箱中已安装并布线完毕，不允许改变该布线。 
调试示例项目时不允许在电机上进行其他组件或驱动负载的连接。 

 

图 4-2 布线原理图 

 

 
说明 
以下说明仅针对两台电机中的一台电机。  

 



 

STARTER 入门指南 
入门指南, (GS1) 07/2016, 6SL3097-4AG00-0RP4 33 

 创建驱动对象 5 
5.1 一览 

本示例将介绍如何使用调试工具STARTER新建驱动项目， 
接着介绍如何通过通讯接口将驱动项目传输至驱动的控制单元上。 

在本例中，编程器（PG/PC）和控制单元（CU）之间的数据交换通过以太网接口（集成

在每个SINAMICS S120设备中）进行。 PROFIBUS 接口或 PROFINET 
接口上的调试也与此类似。  

编程器和驱动（在本例中为培训箱）均已接通且通过数据电缆互相连接。  

 



创建驱动对象  
5.2 设置通讯接口 
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5.2 设置通讯接口 

5.2.1 设置以太网接口 

编程器（PG/PC）可通过以太网接口与控制单元相连以进行调试。 
为此必须先设置编程器的通讯接口。  

 

 
说明 
以下步骤针对的是Windows 7操作系统，在其他操作系统上（例如：Windows 
XP）步骤可能会有所偏差。  

 

编程器的通讯接口  

1. 在编程器（PG/PC）中通过菜单“开始 > 控制面板”调用控制面板。 

2. 调用编程器控制面板”网络和Internet“下的”网络和共享中心“功能。 

3. 在所显示的网卡下点击连接的链接。 

4. 在连接的状态对话框中点击”属性“并在接着出现的安全性询问中选择”是“。 

5. 在连接的属性对话框中勾选”互联网协议 4 (TCP/IPv4)“，然后点击”属性“。 

6. 勾选属性对话框中的选项“使用下面的IP地址”。 



 创建驱动对象 
 5.2 设置通讯接口 

STARTER 入门指南 
入门指南, (GS1) 07/2016, 6SL3097-4AG00-0RP4 35 

7. 将 PG/PC 与控制单元的访问接口的 IP 地址设为 169.254.11.1，子网掩码设为 
255.255.0.0。 

 
图 5-1 举例： PG/PC 的 IPv4 地址 

8. 点击“确定”，关闭Windows网络连接窗口。 

5.2.2 调用 STARTER 
 

 
说明 
以下步骤针对的是Windows 7操作系统，在其他操作系统上（例如：Windows 
XP）步骤可能会有所偏差。  

 

1. 点击用户界面上的 STARTER 图标 。 

或者 

2. 在 Windows 开始菜单中选择 “开始 > STARTER > STARTER” 来启动 STARTER。 
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5.2.3 在STARTER中分配以太网接口 

分配通讯接口  

1. 在 STARTER 中调用菜单“Options > Set PG/PC interface...”。 

窗口“Set PG/PC Interface”打开： 

 
图 5-2 创建访问点 

2. 检查应用的访问点，此处必须设置为“DEVICE (STARTER, SCOUT) ...”。  
必要时通过下拉列表“Access point of the application”修改访问点。 

 
  

说明 
在示例项目中接口的名称为TCP/IP -> Belkin F5D 5055 Gigabit USB 2.0 Network 
Adapter。 
原则上可以使用任意的 PG/PC 以太网接口。 
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3. 如果列表中已有所需适配器，请继续执行第 6 步。  
如果列表中没有所需的适配器，则必须进行添加。点击按钮“Select...”。 

在“Install/uninstall interfaces”窗口的右侧会显示已经安装好的接口。 
如果其中没有所需接口，则必须自行安装。  

 
图 5-3 选择接口 

4. 在左侧选中所需的接口并点击“Install-->”， 

然后接口会被传到右侧。 

5. 选中所需的接口并关闭窗口。 

6. 在下拉列表“Interface Parameter Assignment Used：”中点击“TCP/IP -> Belkin F5D 
5055 Gigabit USB 2.0 Network Adapter”。 

7. 点击“OK”，关闭“Set PG/PC interface”窗口。 
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5.3 创建驱动项目 
STARTER 中项目向导可引导您执行新建驱动项目的必要步骤。 

步骤 
1. 在 STARTER 中调用菜单“Project > New with wizard”。 

项目向导的引导窗口打开。 

 
图 5-4 在线搜索驱动设备 

2. 点击按钮 “Find drive units online...”。 

第 1 步，项目向导打开窗口“Creat new project”。 

3. 在输入栏中输入项目名称，例如“Project”。 

 
图 5-5 创建新项目 
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4. 点击“Next >”。 

第 2 步，项目向导打开窗口“Set PG/PC interface”。 

 
图 5-6 设置 PG/PC 接口 

5. 您可以在这个窗口中检查先前章节中的通讯接口设置，无需改变窗口中的任何内容。

点击“Next >”。 

第 3 步，项目向导搜索驱动设备。 找到的驱动设备显示在“Preview”中。 

 
图 5-7 添加驱动设备 
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6. 点击“Next >”。 

第 4 步，项目向导显示所选设置的摘要。 

 
图 5-8 总结 

7. 点击按钮“Complete”。 

项目向导关闭窗口。  

然后在示例项目的项目导航区显示找到的驱动设备“S120_CU320_2_DP”。  

 
图 5-9 驱动对象已创建 
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 配置驱动对象 6 
6.1 配置驱动设备 

在示例配置中对驱动设备“S120_CU320_2_DP”进行在线配置。通过自动配置可首先恢复

驱动的出厂设置，然后采用标准配置。  

步骤 

1. 调用菜单命令“Project > Connect to selected target devices”，切换到在线模式。 

首次连接目标设备时会打开目标设备选择窗口，在访问点一栏勾选“DEVICE”。  

 
图 6-1 选择目标设备 
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2. 勾选所需目标设备并点击“OK”。 

目标设备选择窗口关闭，在线模式激活。  
 

  
说明 

在线/离线之间的对比 
如果以相同方法连续创建了多个项目，在目标设备选择窗口关闭后会弹出对话框“Onlin
e/Offline 
Comparison”。该对话框指出（培训箱的）驱动对象中保存的数据与新项目中的数据不

一致。通常这是因为前一个项目的专家列表中所作设置已经保存在目标设备（培训箱

）中，但是还未保存在通过STARTER新创建的项目中（参见章节“SINAMICS 
S120培训箱的特殊之处 (页 46)”和“调试驱动 (页 49)”）。  
因为在线配置和离线配置必须相同，所以必须比较数据组。  

1. 点击按钮“Load into PG ==>”并点击“OK”确认随后弹出的询问“Load into PG”。 

“Online/Offline Comparision”对话框被清空。  

2. 如果不再有差别，点击“Close”。 

通常，专家列表中已存在培训箱所需设置（参见章节“SINAMICS 
S120培训箱的特殊之处 (页 46)”和“调试驱动 (页 49)”）。  

 

3. 在项目导航器中点击“S120_CU320_2_DP”前的“+”号。 

该驱动的对象列表打开，显示如下： 

 
图 6-2 调用自动配置 
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4. 在项目导航器中双击“Automatic Configuration”。 

打开以下窗口： 

 
图 6-3 自动配置准备就绪 

5. 点击按钮“Configure”，开始驱动设备的自动配置。 

编程器（PG/PC）对 DRIVE-CLiQ 
总线上连接的对象进行查找。在示例项目中，PG/PC 找到了两个驱动。 

6. 在列表“Default setting for all components”中选择“Servo”。 

这样，示例项目中的驱动就设置为伺服控制。 

 
图 6-4 自动配置中的驱动选择 
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7. 点击按钮“Create”。 

开始自动配置。过程结束后会显示信息窗口“Automatic configuration completed”。 

 
图 6-5 自动配置中的保持在线 

 
  

说明 
因为在培训箱中集成了两个驱动，因此会出现上述信息。本示例配置中只需调试一个

驱动。  
 

8. 点击按钮“Stay ONLINE”。 
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6.2 配置电机模块 
在自动配置过程中，控制单元已识别到相连接的电机模块和 SMI 电机。 
设备数据已传输到控制单元上。 
控制单元已自动将正确的设备数据记录在设备运行参数中。 

此时示例项目就已完成调试的准备工作。  
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6.3 SINAMICS S120培训箱的特殊之处 
 

如果使用SITRAIN常用的SINAMICS S120培训箱，则必须注意以下几个特殊之处： 

示例配置中使用的电机 

在本示例中我们只调试带 DRIVE-CLiQ 
接口的电机，第二个电机（带增量式编码器）不予考虑。 

定义供电运行信息 
 

 
说明 
下文说明的设置仅针对本例。如果已经采用了前一个项目中的数据，只需复查下文说明的

参数设置。另请参见章节“配置驱动设备 (页 41)”中的“在线/离线之间的对比”说明。  
 

为了进行驱动调试，您必须确定“供电运行信息”的信号源。本例中此信号固定为“1”。 

1. 在项目导航器中点击“S120_CU320_2_DP”前的“+”号。 

2. 在项目导航器中点击驱动“SERVO_02”前的“+”号。 

3. 双击条目“Expert list”。 

4. 在专家列表右侧滚动到 p0864。 

 

图 6-6 专家列表 
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5. 在专家列表此处点击按钮“0”。 

下面的配置对话框打开： 

 

图 6-7 供电运行 

6. 然后选中“1”所在的行并点击“OK”。 

7. 调用菜单命令“Project > Save”，保存示例项目。 
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设备输入电压 

为了进行驱动调试，您必须降低设备输入电压。 

1. 在驱动的专家列表中滚动到 p0210（设备输入电压）。 

 
图 6-8 设备输入电压 

2. 用“300”覆盖掉“Online value SERVO_02”中的值“600”。 

3. 调用菜单命令“Project > Save”，保存示例项目。 
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 调试驱动 7 
 

 

控制面板可以进行操作、监控和测试驱动的基础功能。 可使用图标 “START”、
“STOP”、 “TIP”以及各种诊断功能来运行驱动。  

关于这些功能的更多详细信息请见 SINAMICS S120 驱动功能手册。 

ON/OFF 使能 

1. 在项目导航器中点击“S120_CU320_2_DP”前的“+”号。 

2. 在项目导航器中点击驱动“SERVO_02”前的“+”号。 

3. 双击条目“Expert list”。 

4. 在专家列表右侧滚动到 p0840（ON/OFF 信号）。 

 

图 7-1 ON/OFF 信号 
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5. 在此点击按钮“0”。 

ON/OFF 信号的配置对话框打开： 

 

图 7-2 ON/OFF 配置 

6. 然后选中“1”所在的行并点击“OK”。 
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使用控制面板调试 

1. 在项目导航器中双击条目“S120_CU320_2_DP” > “Drives” > “SERVO_02” > “Commiss
ioning” > “Control panel”。 

 
图 7-3 调用控制面板 

控制面板打开。 

 

图 7-4 控制面板显示 

2. 点击按钮“Assume Control Priority！”。 
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打开窗口“Assume Control Priority”。 

 
图 7-5 获得控制权 

3. 点击按钮“Safety notes”。 

“Safety Notes”窗口打开。 

 
图 7-6 安全提示 

4. 阅读安全提示后关闭窗口。 

5. 在“Assume Control Priority”窗口中点击按钮“Accept”。 
窗口关闭，控制面板激活。 

 
图 7-7 控制面板电机使能 
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6. 勾选复选框“Enables”。 

图标  和 激活。  

7. 在输入栏“n = ”中输入一个电机适用的转速，如“1000”。 

 

图 7-8 控制面板电机运行 

8. 点击图标 。 

电机加速到示例中设定的转速 1000 rpm。 LED“Enable available”显示为绿色 。  

关闭驱动 

1. 如要关闭电机，请点击图标 。 

驱动惯性停车。 

2. 点击按钮“Give up control priority!”，返还控制权。 

3. 点击“Yes”应答询问“Give up control priority”。 

4. 调用菜单命令“Project > Disconnect from target system” 来终止 PG/PC 
和控制单元之间的通讯。 

5. 调用菜单命令“Project > Save”，保存示例项目到 PG/PC 的本地硬盘上。 
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 附录 A 
A.1 重要报警和故障列表 

Axxxxx报警 

Fyyyyy:故障 

 

表格 A- 1 重要故障和报警列表 

号 原因 解决办法 

F07085 控制器参数因以下原因被强行更改：  

• 控制器参数因其他参数超出动态极限。 

• 控制器参数因硬件缺乏某特性而不可用。 
– 故障值（r0949, 十进制）：更改的参数号。 

– 340：电机参数和控制器参数的自动计算已执

行（p0340 = 
1），因为矢量控制作为配置事后激活（r010
8.2）。 

无需采取任何措施。 

无需改变参数，因为已对参数进行了合理的限

制。 

F07802 供电或者驱动在收到内部接通指令后没有回馈

就绪。 

• 监控时间太短。 

• 直流母线电压不存在。 

• 报告组件所属的供电或者驱动有故障。 

• 输入电压设置错误。 

• 延长监控时间(p0857)。 

• 注入直流母线电压。检查直流母线母排。使

能供电。 

• 更换报告组件所属的供电或者驱动。 

• 检查输入电压设置(p0210)。 
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号 原因 解决办法 

F07840 虽然驱动使能存在的时间已经长于设定的监控

时间（p0857）,但仍没有信号“供电运行”。 

• 供电不运行。 

• 用于反馈就绪信号的数字量输入连接错误或

缺少(p0864)。 

• 供电当前正在执行电源识别。 

• 将供电投入运行。 

• 检查用于反馈信号“供电运行”的数字量输入

的连接(p0864)。 

• 延长监控时间(p0857)。 

• 等待电源识别结束。 

A08526 和控制器之间没有建立循环通讯。 建立循环连接并激活循环运行控制系统。 
采用 PROFINET 时，检查参数“站名称”和“站 
IP” (r61000, r61001)。 
如果已经插入了 CBE20 并且希望通过 PZD 
接口 1 进行 PROFIBUS 
通讯，则必须通过调试工具 STARTER 
或直接通过 p8839 进行设置。 
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A.2 恢复出厂设置 
在极少数情况下需要恢复目标设备（即培训箱）的出厂设置。 
培训箱中的模拟驱动因此可再次处于定义状态，配置随后可以更安全的方式重启。 
仅可在在线模式下恢复出厂设置。 

步骤 

1. 调用菜单命令“Project > Connect to selected target devices”，切换到在线模式。  

“Target Device Selection”窗口打开,并显示已配置的驱动设备。  

 
图 A-1 检查访问点 

2. 勾选选项“DEVICE”。 
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3. 勾选复选框“S120_CU320_2_DP”并点击“OK”。 

PG/PC 建立了与控制单元的连接。 PG/PC 执行“Online/Offline Comparison”。 
结果显示在下面的“Online/Offline Comparison”对话框中。 示例： 

 
图 A-2 在线/离线之间的对比 

4. 点击按钮“Close”。 

5. 在项目导航器中选中驱动对象“S120_CU320_2_DP”。 

6. 调用右键菜单“Target device > Restore factory settings”。 

7. 按下“OK”应答询问。 

PG/PC 将驱动参数恢复为出厂设置。  

新状态通过“Copy RAM to ROM”功能自动传输到控制单元的存储卡上。  

8. 在项目导航器中选中驱动设备，调用右键菜单“Target device > Copy from RAM to 
ROM”。 

恢复出厂设置现在完成：驱动处于定义的初始状态下。  
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A.3 手册一览 
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